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1 Overview
“Setting File Creation Software for Smart device control interface” creates a setting file to be used for the Smart 
device control interface.
The created data file is uploaded to each system by using upload function.

2 System requirements
The following shows the ideal system requirements for this software.

The following runtime library is required:
• Microsoft® .NET Framework 2.0 SP2

• “Windows 7”, “Windows 8.1”, “Windows 10” and “Microsoft office” are either registered trademarks or trademarks 
of Microsoft Corporation in the United States and / or other countries.

• Adobe, the Adobe logo, Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and / or other countries.

• InstallShield is either a registered trademark or trademark of Flexera Software Inc. in the United States and / or 
other countries.

• All other company and product names are either registered trademarks or trademarks of the respective owners. 
In this manual such names are not indicated by ™, ® or © marks.

3 Before creating setting files
To use Smart device control interface, the following environment must be prepared.
1. A tablet or smartphone
2. A wireless router1

3. A modem (if using over the Internet)

1 If using over the Internet, a router with the following capabilities is needed.
i) IP Masquerade function
ii) DHCP function (specifiable range) 

Or, a static IP can be assigned to Smart device control interface.

In addition, before uploading data created using this software to Smart device control interface, the tablet or 
smartphone must be in an operational state, and the configuration of the user’s wireless router must be complete. 
For details on wireless router settings, refer to the instructions that came with your wireless router.

Item Specifications
OS Windows 7, Windows 8.1, Windows 10

Office System Office 2007, Office 2010, Office 2013
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4 Workflow of the software
The following flowchart shows the process of creating data with Setting File Creation Software for Smart device 
control interface:

[Flowchart (Preparation)]

Prepare before 
configuring settings

Are the settings 
for the wireless router 

configured?

Wireless router settings
Check the settings, including 
IP address, type of security, 
SSID, and password

NO

Is the smartphone/
tablet connected to the 

wireless router?

Check the connection between 
smartphone/tablet and wireless 
router
• Type of security
• SSID
• Password, etc.

Go to setting file uploading

YES

YES

Install the app on a 
smartphone/tablet

YES

Are proxy or 
DNS settings set for the 

property?

Can the smartphone/
tablet access the Internet 

while connected to the 
wireless router?

Ask the network administrator 
to check the Internet 
connection
• Do the IP segments used by 

the wireless router and 
modem match?

• Is the firewall configured to 
allow the connection?

NO

YES

NO

YES

NO

NO

Will you use 
the Smart device control 

interface over the 
Internet?

Ask the network administrator 
about proxy and DNS settings
• Smart device control interface 

does not support proxy settings.
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[Flowchart (Uploading)]

Connect the computer used for 
configuration and the Smart device 
control interface over a wired LAN

Edit the computer's address so 
that it matches up to the third 
byte, and use an address 
different from the controller's for 
the fourth byte

From Setting File Creation 
Software, execute  
[IP Address Search]

Check the IP address 
of the Smart device control interface

Start uploading

Start configuring
Smart device control interface

settings 

Go to test run

YES

NO

Check that 
the first three bytes of 

the IP segments for the Smart 
deveice control interface and 

configuration computer 
match

Prepare data with Setting File 
Creation Software

• System settings
• IP address setting

(to match the IP segment of the 
wireless router)
(DNS settings (if any))

• Floor name and air conditioner 
name settings

• Air conditioner configuration 
settings

• Selection of Cloud Server to 
connect to

After uploading is finished, 
establish a LAN cable connection 

with the wireless router and 
Smart device control interface 

and turn the power on
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[Flowchart (Test run)]

From the smartphone/tablet app, 
log in to the Smart device control

interface

Switch to a wireless network 
environment that supports access 
from a smartphone/tablet via 4G or 

another Internet connection

Start a test run with the 
Smart device control interface

Check the floor and air conditioner 
names

Operate an air conditioner from the 
smartphone/tablet

Login possible?

Are the floor and air 
conditioner names correct?

Is the air conditioner 
operating correctly?

YES

YES

Return to the setting file uploading 
flowchart
• Does the IP address segment of the 

Smart device control interface match the 
segment of the wireless router?

• Are the wireless router settings correct?

NO

Return to the setting file uploading 
flowchart
• Configure the floor and air conditioner 

name settings again
• Double-check the air conditioner 

address settings

NO

End of test run
Hand over to customer

NO

Login possible?

Return to the setting file uploading 
flowchart
• DNS settings

Ask the network administrator whether 
this product is supported

NO

Connect the smartphone/tablet to 
the wireless router connected with 
the Smart device control interface

YES

Will you use 
the Smart device control 

interface in an environment 
connected to the 

Internet?
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5 Note on using Setting File Creation Software 
for Smart device control interface

Selectable outdoor units / indoor units differ depending on the frequency and region setting. The frequency of an 
already created file cannot be changed.

Fig.1 [Main Menu] screen (Frequency)
– 7 –



Setting File Creation Software for Smart device control interface Operating Instructions

EN
6 Features of Setting File Creation Software 
for Smart device control interface

Creating / editing a setting file
You can create a setting file and edit it.

Fig.2 [Main Menu] screen
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Selecting a BMS System
When creating a new setting file, select a target system.

Fig.3 [Select System] screen

Creating / editing data of a setting file

Fig.4 [System] screen
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Check the version information
Select the [Help] menu then [About] to display the version information.

Fig.5 [Help] menu

Fig.6 [About] screen
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Uploading setting files to the Interface
Specify setting files data, its folder, the target IP address, then upload the files.

Fig.7 [Upload Settings] screen

The following screen is displayed during upload to show the upload progress screen.

 
Fig.8 [Upload Progress] screen
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7 Using the Setting File Creation Software for 
Smart device control interface

Starting / exiting the Setting File Creation Software for Smart 
device control interface

Starting the Setting File Creation Software for Smart device control interface
Use the desktop icon or Windows menu to start the Setting File Creation Software for Smart device control 
interface.

1. Start the Setting File Creation Software for Smart device control interface.

• Desktop icon
Double-click the desktop icon.

Fig.9 [Setting File Creation Software for Smart device control interface desktop icon]

• Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for Smart device control interface].

2. The startup screen appears.
The startup screen appears.

Fig.10 [Startup] screen
12-EN– 12 –



Setting File Creation Software for Smart device control interface Operating Instructions

13-EN
3. Setting File Creation Software for Smart device control interface Startup Complete
The startup screen (Fig.10) disappears, and the Main Menu screen (Fig.2) appears. Setting File Creation Software 
for Smart device control interface startup is now complete, and the software can be operated.

Exiting the Setting File Creation Software for Smart device control interface
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.11 [Main Menu] screen (Close button)

Fig.12 [Main Menu] screen (Exit button)

Fig.13 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [OK] to exit, or [Cancel] to cancel exiting.

Fig.14 Exit confirmation dialog box

[Close] button
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Creating new data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.3) appears.

Fig.15 [Main Menu] screen (New button1)

Fig.16 [Main Menu] screen (New button2)

Fig.17 [Main Menu] screen (New menu)

Click button
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Selecting a file to edit data
Click the [Select File] button, or select the [File] menu then [Open]. The Open screen appears.

Fig.18 [Main Menu] screen (Select File button)

Fig.19 [Main Menu] screen (Open button)

Fig.20 [Main Menu] screen (Open Menu)

Click button

Click button
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When the Open screen has opened, select a file to edit. The System screen (Fig.4) appears.

Fig.21 [Open] screen
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Using a history file to edit data
Double-click a line in the History List, or select a file from Recently Used File. The System screen (Fig.4) appears.

Fig.22 [Main Menu] screen (History List)

Double-click
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Up to 9 files are stored in Recently Used File.

Fig.23 [Main Menu] screen (Recently Used File)
 
If the selected file does not exist, a warning appears.

Fig.24 Warning message box
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Delete the history file
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.25 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.26 Deletion confirmation dialog box

This history item is deleted 
if [Delete Selected History] 
is selected
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Search for the Smart device control interface on the network
If you do not know the IP address of the Smart device control interface on the network, click the [Tool]>[IP Address 
Search]>[Smart device control interface].

Fig.27 [IP Address Search for the Smart device control interface]

A dialog box appears before the search starts to confirm you want to execute the search. To execute the search, 
click the [Device Search] button.

Fig.28 [IP Address Search]

When the search is complete, appears IP address. To exit this dialog box, click the [Close] button.

Fig.29 [IP Address Search]
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Setting up the system
Select the [System] tab and configure the settings.

Fig.30 [System] tab

The following table shows how to enter / select data:

Item Data Type Selection Note
Building Name Entered by user –

Indoor unit total Q'ty Entered by user Numeric value only

Words in error code definition file Selected by user Select from list

Using Cloud Server Selected by user Select from list

Using Region Server Selected by user Select from list

Table.1 How to enter / select data
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Setting up the server
Select the [Server Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.31 [Server Setting] tab

The following table shows how to enter / select data:

Item Data Type Selection Note
IP Address acquisition method Selected by user Select from list

IP Address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

DNS Setting Entered by user

Table.2 How to enter / select data
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Adding an outdoor unit
Click the [New] button, or select the [Operation] menu > [Outdoor Unit] > [New]. A line will be added to the outdoor
unit list.

Fig.32 [Outdoor] tab

Fig.33 [Outdoor] tab (New Menu)

The following table shows how to enter / select data:

Item Data Type Selection Note
LINE No. Cannot be edited

Line address Entered by user Numeric value only

Outdoor unit combination model 
name Selected by user Select from the Select 

outdoor unit model screen

Outdoor unit model name Cannot be edited

Outdoor name Entered by user

Outdoor unit address Cannot be edited

Table.3 How to enter / select data

Click button
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Selecting an outdoor unit
Clicking a cell of an outdoor unit combination model name on the [Outdoor] tab displays the Select outdoor unit 
model screen. On the screen, double-click a cell of an outdoor unit model, or select a model then click the OK 
button. “Outdoor unit combination model name,” “Outdoor unit model name,” and “Outdoor unit address” will 
automatically become available on the [Outdoor] tab. To cancel changing the outdoor unit setting, click the Cancel 
button to return to the [Outdoor] tab.

Fig.34 [Select outdoor unit model] screen
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Copying the data of an outdoor unit
Select a line of an outdoor unit on the [Outdoor] tab, and click the [Copy] button, or select the [Operation] menu > 
[Outdoor Unit] > [Copy]. The copied outdoor unit will be added to the outdoor unit list. The numbers of the copied 
“Line address” and “Outdoor name” will automatically be increased in one.

Fig.35 [Outdoor] tab (Copy button)

Fig.36 [Outdoor] tab (Copy menu)

Click button
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Copying the data of multiple outdoor units
Select a line of outdoor unit on the [Outdoor] tab, and click the [Multicopy] button, or select the [Operation] menu 
> [Outdoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.37 [Outdoor] tab (Multicopy button)

Fig.38 [Outdoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied outdoor units will be added to the outdoor unit list. The 
numbers of the copied “Line address” and “Outdoor name” will automatically be increased in one.

Fig.39 [Copy line count] screen

Click button
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Deleting the data of outdoor units
Select one or more lines of outdoor units on the [Outdoor] tab (Fig.6), and click the [Delete] button, or select the 
[Operation] menu > [Outdoor Unit] > [Delete].

Fig.40 [Outdoor] tab (Delete button)

Fig.41 [Outdoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The outdoor units will be deleted from the outdoor unit list. To cancel deletion, click 
the Cancel button.

Fig.42 Deletion confirmation dialog box

Click button
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Inserting an outdoor unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.6), and click the [Insert] button, or select the [Operation] 
menu > [Outdoor Unit] > [Insert]. A line will be inserted at the selected location in the outdoor unit list.

Fig.43 [Outdoor] tab (Insert button)

Fig.44 [Outdoor] tab (Insert menu)

Click button
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Adding a zone
Click the [New] button, or select the [Operation] menu > [Tree] > [New]. A line will be added to the zone list.

Fig.45 [Zone] tab (New button)

Fig.46 [Zone] tab (Menu)

The following table shows how to enter / select data:

Item Data Type Selection Note
Name Entered by user

Table.4 How to enter / select data

Click button
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Copying the data of a zone
Select a line of a zone on the [Zone] tab, and click the [Copy] button, or select the [Operation] menu > [Tree] > 
[Copy]. The copied zone will be added to the zone list. The number of the copied “Name” will automatically be 
increased in one.

Fig.47 [Zone] tab (Copy button)

Fig.48 [Zone] tab (Copy menu)

Click button
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Copying the data of multiple zones
Select a line of zone on the [Zone] tab, and click the [Multicopy] button, or select the [Operation] menu > [Tree] > 
[Multicopy]. The Copy line count screen appears.

Fig.49 [Zone] tab (Multicopy button)

Fig.50 [Zone] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied zones will be added to the zone list. The number of the 
copied “Name” will automatically be increased in one.

Fig.51 [Copy line count] screen

Click button
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Deleting the data of zones
Select one or more lines of zones on the [Zone] tab (Fig.7), and click the [Delete] button, or select the [Operation] 
menu > [Tree] > [Delete].

Fig.52 [Zone] tab (Delete button)

Fig.53 [Zone] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The zones will be deleted from the zone list. To cancel deletion, click the Cancel 
button.

Fig.54 Deletion confirmation dialog box

Note that the following data will also be deleted if a zone is deleted:
• The Zone setting of an indoor unit set to the deleted zone

Click button
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Inserting a zone
Select a line of a zone on the [Zone] tab (Fig.7), and click the [Insert] button, or select the [Operation] menu > [Tree] 
> [Insert]. A line will be inserted at the selected location in the zone list.

Fig.55 [Zone] tab (Insert button)

Fig.56 [Zone] tab (Insert menu)

Click button
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Renumbering the zones
Click the [Renumber] button, or select the [Operation] menu > [Tree] > [Renumber]. The numbers in the “No” 
column will be reassigned.

Fig.57 [Zone] tab (Renumber button)

Fig.58 [Zone] tab (Renumber menu)

Click button
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Changing the order of the zones
Select a line of a zone on the [Zone] tab, and click the [Up] / [Down] button, or select the [Operation] menu > [Tree] 
> [Up] / [Down]. The selected line moves up or down.

Fig.59 [Zone] tab (Up button)

Fig.60 [Zone] tab (Down button)

Fig.61 [Zone] tab (Up menu)

Fig.62 [Zone] tab (Down menu)
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Adding an indoor unit
Click the [New] button, or select the [Operation] menu > [Indoor Unit] > [New]. A line will be added to the indoor 
unit list.

Fig.63 [Indoor] tab (New button)

Fig.64 [Indoor] tab (New menu)

The following table shows how to enter / select data:

Item Data Type Selection Note
LINE No. Cannot be edited

Line Address Entered by user

Indoor unit address Entered by user

Parent Indoor Unit No. Entered by user

Indoor unit model name Selected by user Select from the Select 
indoor unit model screen

R.C.group / indoor name Entered by user

Floor name Selected by user Select from list

Air Conditioner No. Entered by user

Table.5 How to enter / select data

Click button
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Selecting an Indoor Unit
Clicking a cell of an indoor unit model name on the [Indoor] tab (Fig.8) displays the Select indoor unit model screen. 
On the screen, double-click a cell of an indoor unit model, or select a model then click the OK button. “Indoor unit 
model name” will automatically become available on the [Indoor] tab (Fig.8). To cancel changing the indoor unit 
setting, click the Cancel button to return to the [Indoor] tab.

Fig.65 [Select indoor unit model] screen
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Copying the data of an indoor unit
Select a line of an indoor unit on the [Indoor] tab, and click the [Copy] button, or select the [Operation] menu > 
[Indoor Unit] > [Copy]. The copied indoor unit will be added to the indoor unit list. The numbers of the copied “Indoor 
unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.66 [Indoor] tab (Copy button)

Fig.67 [Indoor] tab (Copy menu)

Click button
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Copying the data of multiple indoor units
Select a line of indoor unit on the [Indoor] tab (Fig.8), and click the [Multicopy] button, or select the [Operation] menu 
> [Indoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.68 [Indoor] tab (Multicopy button)

Fig.69 [Indoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied indoor units will be added to the indoor unit list. The 
numbers of the copied “Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.70 [Copy line count] screen

Click button
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Deleting the indoor units
Select one or more lines of indoor units on the [Indoor] tab (Fig.8), and click the [Delete] button, or select the 
[Operation] menu > [Indoor Unit] > [Delete].

Fig.71 [Indoor] tab (Delete button)

Fig.72 [Indoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The indoor units will be deleted from the indoor unit list. To cancel deletion, click the 
Cancel button.

Fig.73 Deletion confirmation dialog box

Click button
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Inserting an indoor unit
Select a line of an indoor unit on the [Indoor] tab (Fig.8), and click the [Insert] button, or select the [Operation] menu 
> [Indoor Unit] > [Insert]. A line will be inserted at the selected location in the indoor unit list.

Fig.74 [Indoor] tab (Insert button)

Fig.75 [Indoor] tab (Insert menu)

Click button
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Changing the order of the indoor units
Select a line of an indoor unit on the [Indoor] tab, and click the [Up] / [Down] button, or select the [Operation] menu 
> [Indoor Unit] > [Up] / [Down]. The selected line moves up or down.

Fig.76 [Indoor Unit] tab (Up button)

Fig.77 [Indoor Unit] tab (Down button)

Fig.78 [Indoor Unit] tab (Up menu)

Fig.79 [Indoor Unit] tab (Down menu)

Click button

Click button
42-EN– 42 –



Setting File Creation Software for Smart device control interface Operating Instructions

43-EN
Deleting all air conditioner No. of the indoor units
Click the [Clear] button, or select the [Operation] menu > [Indoor Unit] > [Clear]. All the Air Conditioner No. will be 
deleted.

Fig.80 [Indoor Unit] tab (Clear button)

Fig.81 [Indoor Unit] tab (Clear menu)

Click button
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Saving created data to a file
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.82 [Save] button

Fig.83 [Save Setting File] menu

Fig.84 [Save Setting File As] menu

Click button
44-EN– 44 –



Setting File Creation Software for Smart device control interface Operating Instructions

45-EN
When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.85 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.86 Overwrite confirmation dialog box
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Outputting a DEF File
Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.87 [Output File] button

Fig.88 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.89 Overwrite confirmation dialog box

Click button
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The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.90 [Browse For Folder] screen

The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the
section containing the error.

Fig.91 Example of error message box

When the DEF file output is complete, a message appears. Select the “Start up the upload screen.” checkbox and
click the OK button. The upload screen appears.

Fig.92 DEF file output complete dialog box
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Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.93 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.94 Deletion confirmation dialog box

This history item is deleted 
if [Delete Selected History] 
is selected
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Uploading a setting file (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen or [Data Input Main] 
screen. The Upload Settings screen appears.

Fig.95 [Main Menu] screen (Upload button)

Fig.96 [Main Menu] screen (Upload menu)

Fig.97 [Data Input Main] screen (Upload button)

Fig.98 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.99 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.100 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder. When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.101 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.102 [Browse For Folder] screen

Click button
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Specifying a Target System
Select a destination system to upload the file to. When setting file data is specified, the system is automatically 
selected depending on the settings.

Fig.103 [Upload Settings] screen (Target System)

Specifying an IP Address
Specify the IP address of the destination system.
When setting file data is specified, the address automatically appears.

Fig.104 [Upload Settings] screen (IP Address)
52-EN– 52 –



Setting File Creation Software for Smart device control interface Operating Instructions

53-EN
The following table shows the items in the File List:

Starting the Upload
After the preparation (P61 to P64) has been completed, click the Upload button. The upload starts.

Fig.105 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.106 Progress bar

Item Content
File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

Click button
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System settings

System Tab
The following table shows the settings configured on the System tab:

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Outdoor Tab
The following table shows the settings configured on the Outdoor tab:

Item Content Data type / range
Building Name Building name Characters (Up to 100 bytes, Forbidden: ; : , #)  

Indoor unit total Q’ty Number of indoor units 1 - 32

Words in error code definition file Time when the daily report 
is output  

1: English
2: Chinese (Simplified)
4: Deutsch
5: Espanol
6: Francais
7: Italiano
8: Korean
9: Portuguese
10: Dutch
11: Russian
12: Turkish
13: Greek
14: Czech
15: Croatian
16: Polish

Using Cloud Server This system connects to 
Internet or not

0: Valid
1: Void

Using Region Server Select the server to 
connect to

0: Europe Server
1: Asia Server

Item Content Data type / range

IP Address acquisition method Select whether to enter IP address or auto 
assign by DHCP

IP Address IP address of Smart device control interface Numeric value

Subnet Mask Subnet mask of Smart device control 
interface Numeric value

Default Gateway Gateway of Smart device control interface Numeric value

Proxy Setting Proxy Setting of Smart device control 
interface Characters

DNS Setting DNS Setting of Smart device control 
interface Characters

Item Content Data type / range
LINE No. Cannot be edited 1

Line address Refrigerant line number 1 - 32

Outdoor unit combination model name Select the outdoor unit models

Outdoor unit model name Select the outdoor unit models

Outdoor name Enter the line name Character

Outdoor unit address Unit number
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Zone Tab (Floor only)
The following table shows the settings configured on the Zone tab:

Indoor Tab
The following table shows the settings configured on the Indoor tab:

Item Content Data type / range
Name Floor name Characters (Up to 100 bytes, Forbidden: ; : , #)

Item Content Data type / range
LINE No. Cannot be edited 1

Line Address Refrigerant line number 1 - 32

Indoor unit address Unit number 1 - 64

Parent Indoor Unit No. Number to distinguish parent and 
child

0: Parent
1 – 32: Child

Indoor unit model name Select from indoor unit models

R.C.group / indoor name Enter the line name Characters (Up to 100 bytes, Forbidden: ; : , #)

Floor name Select the floor No setting
Floor name list

Air Conditioner No. Air-conditioner number 1 - 32
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8 Creating a setting file using the import 
function

Outputting a template
Output a template (Excel file) in which you enter information on an air conditioner connected to a BMS model.
Select the [Tool] menu then [Output Template] on the Main Menu screen, and then select a BMS model.

Fig.107 [Main Menu] screen
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Select the destination folder and enter a file name to save the template. A message appears, and then the template 
is output.

Fig.108 [Save As] screen

Fig.109 Output completion dialog box

Fig.110 Template for Smart device control interface
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Setting air conditioner information in the template
Set the air conditioner name, model name, address, zone. For the model name, refer to the model list output by 
selecting [Tool] > [Output Template] > [Model List] on the Main Menu screen.

Fig.111 Example: Template for Smart device control interface

Fig.112 [Model List]
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Importing
Apply air conditioner information in the Excel file to the Setting File Creation Software by selecting and importing 
a file containing the air conditioner information as a template.
Select the [Tool] menu then [Import] on the Main Menu screen, and then select a BMS model.

Fig.113 [Main Menu] screen
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Select an Excel file to import. The import starts.

Fig.114 [Open] screen

The import starts, and the progress bar appears.

Fig.115 Progress bar

An error occurs if the Excel file to import is opened. Close the Excel file.

Fig.116 Progress bar
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An error occurs if the Excel file to import contains an error. The cause and line No. are displayed. Check the Excel 
file. (Example: The model name does not exist, the indoor unit No. is duplicate)

Fig.117 Error message (Example: The indoor unit No. is duplicate)

When the import is complete, the Data Input Main screen appears. Configure the settings on the System tab, the 
pulse constant of Energy Monitoring Relay Interface Q’ty, etc. If other settings need to be changed, change them.

Fig.118 [Data Input Main] screen (System tab)
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Mail setting function
Smart device control interface contains a function to send e-mail automatically to a registered e-mail address when 
an error has occurred. This chapter describes the mail function setting.
Select [Operation] > [Mail Setting] on the Data Input Main screen. The [E-Mail Setting] screen appears.

Fig.119 [Mail Setting] menu

Fig.120 [E-Mail Setting] screen

Item Content Data type / range

E-mail Address Sender's e-mail address
Text (Up to 64 characters, Forbidden characters: “<” “>” “ ” 
” “&” “\n” “;” “,” “{” “}”“+” “?” “`” “[” “]” “/” “#” “$” “%” “(” “)” “=” 
“~”“|” “\” “^” “:” “*”)

Subject Subject of the sent e-mail Text (Up to 64 characters, Forbidden characters: “<” “>” “ ” 
” “&” “\n” “;” “,”)

Contents Body of the sent e-mail 
(Line 1)

Text (Up to 64 characters, Forbidden characters: “<” “>” “ ” 
” “&” “\n” “;” “,”)

SMTP: IP Address IP address of the SMTP 
server Numeric value

SMTP: PortNumber Port number of the SMTP 
server Numeric value (0 – 65535)
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When “Edit Port Number” for SMTP / POP is selected, you can edit the port number.

Fig.121 [E-Mail Setting] screen (SMTP Server)

When the OK button is clicked, the entered settings are checked before being saved. If there are no problems, the 
settings are saved, and the Data Input Main screen reappears. If any problems are found, the focus moves to the 
field concerned, and an error message such as the following appears:

Fig.122 Error message box example

If any settings have been changed when the Cancel button is clicked, a confirmation message appears. If the OK 
button is clicked, the change is discarded and the Data Input Main screen reappears. If the Cancel button is clicked, 
the E-Mail Setting screen reappears.

Fig.123 Edit deletion confirmation dialog box
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9 Initialization tool

Initialization tool
The Initialization Tool resets the air-conditioner setting file data stored on Smart device control interface, such as 
the schedule data, alarm history data to the factory default.
The tool contains the Restore function, which restores using data backed up during initialization.

Starting / exiting the initialization tool

Starting the Initialization Tool
Use the menu of the Setting File Creation Software for BMS System or Windows menu to start the Initialization 
Tool.
Menu of the Setting File Creation Software for BMS System

Fig.124 [Open] screen

Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for Smart device control interface] > 
[Initialization Tool].
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Exiting the Initialization Tool
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.125 [Main Menu] screen (Close button / Exit button)

Fig.126 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [OK] to exit, or [Cancel] to cancel exiting.

Fig.127 Exit confirmation dialog box

Click button
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Initializing data in a target system

Initializing a Setting File
When a setting file is initialized, the schedule data, alarm history will be deleted in addition to the setting file.
Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Select [Initialize Setting Files].

4 Specify a backup folder. (Fig.366)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Program Data\Toshiba Carrier Corporation\Initialization Tool\backup” in Windows 7/
8.1/10. This folder is a hidden folder. To show the folder, you need to change the “Folder Options” settings.

5 Use the PING command to check the connection to the target system.

Fig.128 [Initialization Tool] screen
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Fig.129 [Browse For Folder] screen

6 Click the [Execute] button, or select the [Operation] menu then [Execute].

Fig.130 [Initialization Tool] screen (Execute button / Execute menu)

7 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.131 [Warning] screen
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8 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.132 Progress bar

9 If the initialization is completed successfully, the completion dialog box appears.

10 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned off, wait until 
over a minute passes before turning it back on.

Fig.133 Completion dialog box
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10 License agreement
Before using “Setting File Creation Software for Smart device control interface” (hereinafter referred to as “this 
software,” read this software's license agreement (hereinafter referred to as “this agreement”) carefully.
By using or installing this software in part or as a whole, you agree to be bound by the terms of this agreement.
If you (hereinafter referred to as “the user”) do not agree to the terms of this agreement, return it to the place of 
purchase without using or installing this software.

1. Under this agreement, this software means a computer program that is accompanied by this agreement as a 
recording medium or file, plus any and all other data including electronic documentation provided. Data that is 
explicitly not contained in this software is excluded.

2. Toshiba Carrier Corporation retains the ownership and intellectual property rights to this software. The user 
may use this software by agreeing to the terms and conditions of this agreement for purposes designated by 
Toshiba Carrier Corporation or agreed upon by Toshiba Carrier Corporation and the user.

3. Toshiba Carrier Corporation owns the copyright to this software. This software is protected by copyright laws 
and international treaties.

4. The user may duplicate and install this software for purposes described in the documentation for this software. 
The user shall immediately delete a copy of this software when it becomes unnecessary. Excluding the above 
case, the user shall not duplicate this software.

5. The user shall make no attempt to reverse engineer, decompile, disassemble, or alter this software.

6. The user shall not let any other users use this software over a local network or the Internet.

7. The user shall not distribute, give, rent, lease, sell, or sublicense this software or the right to use this software 
to any third party.

8. The user shall respect the intellectual property rights of this software. In addition, the user shall recognize that 
this software is confidential and avoid disclosing this software to any third party.

9. The user agrees to comply with the Foreign Exchange and Foreign Trade Control Law, the Export Trade 
Control Order, the United States Export Administration Act and all applicable international and national laws 
and regulations that apply to this software directly or indirectly.

10. The user is allowed to use this software as is without any explicit or implicit guarantee. No implicit commercial 
guarantees or specific purpose applicability guarantees apply. Toshiba Carrier Corporation has no 
responsibility to guarantee the quality or performance of this software. Toshiba Carrier Corporation has no 
responsibility whatsoever for any damage, loss, cost or expense, incurred by the user, arising from the use of 
this software.

11. If the terms of this agreement are violated or this agreement is cancelled, the user shall uninstall and remove 
this software, and return the recording media and files (including copies) to Toshiba Carrier Corporation.

12. Toshiba Carrier Corporation reserves the right to terminate the use of this software and modify or improve this 
software at any time.

13. This agreement will be governed by and construed in accordance with the laws of Japan. (However, the 
applicable law selection rules are excluded. Hereinafter the same shall apply)
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